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An easy guide to installing and upgrading  
WorldShip software.
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WorldShip 2012 Pre-Installation Checklist

1. Check Compatibility:

	� You may have integrated WorldShip with a UPS Ready®  
(or third-party) vendor application. Due to changes in the 
WorldShip database structure, these applications may not 
be compatible with WorldShip 2012. 

	� Do not upgrade until you contact the UPS Ready  
(or other third-party) vendor.

2. Check Operating System and Service Pack:

	� The WorldShip 2012 upgrade requires that you have either 
Microsoft® Windows® XP Service Pack 2 or higher or  
Microsoft Windows Vista®/Windows 7 to begin installation.

	� To identify which Operating System and Service Pack  
you have:

	 n �Click Start on the Windows taskbar, point to Programs, 
Accessories and System Tools and select System  
Information.

	 n �The Operating System version and Service Pack will display 
in the System Information window.

	 n �If you have Microsoft Windows XP and the Service Pack  
is lower than version 2, select the link below to download  
and install the Service Pack. The PC will be evaluated  
for available updates by Microsoft. Microsoft Windows XP 
Service Pack 2 will appear as a critical update.  
WindowsUpdate.Microsoft.com 

	 n �If you wish only to install Microsoft Windows XP Service 
Pack 2, clear all other updates offered.

	� Memory recommendations:

	 n Windows XP (512 MB)

	 n Windows Vista (1 GB)

	 n Windows 7 (1 GB - 32 bit and 2 GB - 64 bit)

	 �CAUTION: Do not proceed if your system is not at the proper 
Operating System and Service Pack version.

3. Check for Administrative Rights:

	� Ensure that the user account used to log into Microsoft  
Windows operating systems has full PC administrative 
rights. If unsure, consult the computer technical support 
staff at your company. Due to security enhancements, 
Microsoft Windows Vista/Windows 7 users may be required  
to authenticate with administrative rights during the 
installation process. The User Account Control (UAC) prompt 
may appear several times during installation asking you for 
permission to let WorldShip install its components. You must 
acknowledge the UAC prompt and allow the installation  
to continue.

	� Also, if you need to access the WorldShip Support Utility  
for any reason, you must run this utility with administrative 
rights. To perform this task:

	 n �Click Start on the Windows taskbar, point to Programs  
and UPS, right-click UPS WorldShip Support Utility  
and select Run As Administrator.

4. �Archive WorldShip Shipping History to improve performance:

	 n Start WorldShip.

	 n Press F3 to open the Shipment History window.

	 n On the File menu, select Archive Shipments.

	 n �In the Archive Shipments window, select All Shipments,  
or specify a date range, and then click OK.

	 n In the Save As window, click Save.

	 n �Click Yes in the confirmation window.

		�  Note: The last 14 days of history will not be deleted,  
and the history that is deleted may be restored at any  
later time when needed.

	 n �Click Done when 100% is reached in the Archive 
Shipments window.

	 n �Click Yes in the window that appears requesting  
the database backup to be performed.
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5. �Check for Anti-spyware, Anti-malware and Virus Scanner 
software:

	� Anti-spyware, anti-malware, and virus scanner software 
may conflict with the WorldShip installation.

6. Shut Down Open Applications:

	� Shut down all other programs running on the taskbar, 
including Microsoft Outlook®, Internet Explorer®, Excel®, etc.

CAUTION: Microsoft Windows Vista/Windows 7 users please 
read below.

During the WorldShip installation process, your PC will be 
required to restart. After restart, Microsoft Windows Vista/
Windows 7 may prevent the WorldShip application from 
automatically launching to complete the installation. Please 
launch WorldShip using the icon on your desktop should  
this happen. If you chose not to place the WorldShip icon  
on your desktop, you may launch WorldShip by clicking Start 
on the Windows taskbar, pointing to Programs and UPS and 
selecting UPS WorldShip.

Upgrading

WorldShip 2012 may have different system requirements.  
A complete list can be found on the CD packaging or at  
ups.com/worldship.

Note: WorldShip 2012 will only upgrade WorldShip 2010 (v12) 
and WorldShip 2011 (v14).

1. �Complete the End Of Day process prior to upgrading (if  
needed). Restart WorldShip once End Of Day has completed. 

2. �Insert the WorldShip CD into the CD-ROM drive. If your 
system supports the auto-run feature, installation begins 
automatically.

	 n �If your system does not support the auto-run feature,  
click Start on the taskbar, select Run, then enter the letter 
of the CD-ROM drive, and the word setup, for example:  
D:\SETUP.

	 n �Then click OK.

3. �On the WorldShip Set-up screen, choose the following:

	 n �Application Language — Select the language in which 
you want WorldShip installed.

	 n �Install Location — This field is read-only.

	 n �Country/Territory of Installation — This field could  
be read-only.

	 n �When you are finished, click on Next.

4. �On the Licence Agreement screen, accept the UPS 
Technology Agreement by selecting I Accept the Terms  
in the Licence Agreement and then click Install.

5. �Wait while the installation process upgrades WorldShip. At 
the end of a successful installation, you will be prompted 
to reboot your computer. If your PC requires a password, 
log in and enter the password. 

6. Remove the CD from the CD-ROM drive.

Installing 

You can install WorldShip on a Single workstation or on a 
workstation that’s part of a Workgroup. WorldShip should 
not be installed on a server.

Installing on a Single Workstation:
1. �Insert the WorldShip CD into the CD-ROM drive. If your 

system supports the auto-run feature, installation begins 
automatically.

2. On the WorldShip Setup screen, choose the following:

	 n �Application Language — Select the language in which 
you want WorldShip installed.

	 n �Install Location — Click on Browse and then select where 
you want WorldShip installed. WorldShip will create the 
folders \UPS\WSTD and place them under the location 
you choose.

	 n �Country/Territory of Installation — Select the country/ 
territory where WorldShip is to be installed.

	 n �Select or clear the Add Shortcut to WorldShip  
on Desktop tick box as needed.

	 n �When you are finished, click on Next.

3. �On the Licence Agreement screen, accept the UPS 
Technology Agreement by selecting I Accept the Terms  
in the Licence Agreement and then click on Next.
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4. �On the Installation Type Selection screen, select Single 
Workstation and click on Install.

5. �Wait until the installation process has upgraded WorldShip. 
At the end of a successful installation, you will be prompted 
to reboot your computer. If your PC requires a password, 
log in and enter the password.

6. Remove the CD from the CD-ROM drive.

Note: If you recently installed TCP/IP, Dial-Up Networking �
or a modem, you may see other windows or be asked for 
additional information.

Installing on a Network:
If you want to allow multiple shippers to process packages 
using the same database, then you may install WorldShip 
in a Workgroup configuration grouping. Installing WorldShip 
in a Workgroup configuration requires that a single 
Workgroup Administrative workstation be installed first. 
After the Workgroup Administrative workstation has been 
installed, one or many Workgroup Remote workstations 
may be installed to share the database that is located on 
the Workgroup Administrative workstation. WorldShip is 
designed to have the database reside on the Workgroup 
Administrative workstation. WorldShip is not designed 
to have the database shared on a network file server. 
Additionally, a Workgroup configuration grouping requires 
that a “shared network drive folder” be defined. The 
shared network drive is the location for files (other than 
the database) that will need to be accessed by all of the 
workstations in the Workgroup configuration grouping.

Note: You can configure the Task Scheduler in WorldShip  
to make daily backups of the database. Those backups could 
be stored on a server. For step-by-step instructions, select 
WorldShip Help from the Help menu and type Task Schedule 
Editor Procedures.

Pre-Installation Instructions: Create a folder in which  
to install the shared WorldShip files. This folder must be  
a shared Microsoft® folder and can reside on either the 
Workgroup Administrative workstation or on any drive that  
is accessible from the Workgroup Administrative workstation  
as well as the Workgroup Remote workstations. These files 
should be installed in a different folder than the local files. 

Workgroup Administrative Workstation:
1. �Insert the WorldShip CD into the CD-ROM drive. If  

your system supports the auto-run feature, installation 
begins automatically.

2. On the WorldShip Set-up screen, choose the following:

	 n �Application Language — Select the language in which 
you want WorldShip installed.

	 n �Install Location — Click on Browse and then select where 
you want WorldShip installed. WorldShip will create the 
folders \UPS\WSTD and place them under the location 
you choose.

	 n �Country/Territory of Installation — Select the country/ 
territory where WorldShip is to be installed.

	 n �Select or clear the Add Shortcut to WorldShip  
on Desktop tick box as needed.

	 n �When you have finished, click Next.

3. �On the Licence Agreement screen, accept the UPS 
Technology Agreement by selecting I Accept the Terms  
in the Licence Agreement and then click on Next.

4. �On the Installation Type Selection screen, choose the 
following:

	 n �For the desired installation type, select Workgroup Admin.

	 n �For the location to install shared files by both the Admin 
and Remote, click on Browse and select the location in 
the Workgroup Admin Shared Location box.

	 n �When you are finished, click on Install.

5. �Wait until the installation process has copied the files. At 
the end of a successful installation, you will be prompted 
to reboot your computer. If your PC requires a password, 
you will need to log in and enter the password.

6. Remove the CD from the CD-ROM drive.

Workgroup Remote Workstation(s):
By default, the Workgroup Remote workstation can perform 
limited functionality. The Workgroup Administrator can configure 
remotes to perform additional WorldShip functions.

Note: There are two methods of installing a Workgroup �
Remote workstation: installing from the CD or installing �
from a shared drive.
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Installing from the CD:

1. �Insert the WorldShip CD into the CD-ROM drive. If your 
system supports the auto-run feature, installation begins 
automatically.

2. �On the WorldShip Set-up screen, choose the following:

	 n �Application Language — Select the language in which 
you want WorldShip installed.

	 n �Install Location — Click on Browse and then select where 
you want WorldShip installed. WorldShip will create the 
folders \UPS\WSTD and place them under the location 
you choose.

	 n �Country/Territory of Installation — Select the country/
territory where WorldShip is to be installed.

	 n �Select or clear the Add Shortcut to WorldShip  
on Desktop check box as needed.

	 n �When you have finished, click Next.

3. �On the Licence Agreement screen, accept the UPS 
Technology Agreement by selecting I Accept the Terms  
in the Licence Agreement and then click on Next.

4. �On the Installation Type Selection screen, choose the 
following:

	 n �For the desired installation type, select Workgroup Remote.

	 n �For the location to install shared files installed by the 
Admin, click on Browse and select the location in the 
Workgroup Admin Shared Location box.

	 n �When you have finished, click on Install.

5. �Wait while the installation process copies the files. At  
the end of a successful installation, you will be prompted 
to reboot your computer. If your PC requires a password, 
you will need to log in and enter the password.

6. Remove the CD from the CD-ROM drive.

Installing from a shared drive:

You have the option of installing Workgroup Remote work
stations from install files stored on the shared drive (the 
shared drive location was designated during the installation 
of the Workgroup Administrative workstation). The install 
files can be found in the \UPS\WSTD\Remote\Install\Disk1 
subdirectory of the shared drive folder.

1. �On the WorldShip Set-up screen, choose the following:

	 n �Local Destination Directory — Click on Browse and then 
select where you want WorldShip installed. WorldShip 
will create the folders \UPS\WSTD and place them under 
whatever location you choose.

	 n �Workgroup Administrator Shared Location — This field  
is read-only and displays the shared location set up  
by the Workgroup Administrator.

	 n �Country/Territory of Installation — Select the country/
territory where WorldShip is to be installed.

	 n �By default, a shortcut to WorldShip will be created on 
your desktop.

	 n �When you are finished, click Next.

2. �On the License Agreement screen, accept the UPS 
Technology Agreement by selecting I Accept the Terms  
in the Licence Agreement and then click on Install.

3.	�Wait while the installation process copies the files. At  
the end of a successful installation, you will be prompted  
to reboot your computer. If your PC requires a password, 
you will need to log in and enter the password.

Setting Up Communications
WorldShip requires electronic communications to transmit 
package and tracking information. If you do not currently 
have direct access or dial-up access to the Internet, the 
software provides access to UPS Web sites only. 

Preparing for communications: 
To prepare for communications, the following items must  
be installed on your computer:

n For Direct Access: TCP/IP. 

n �For Dial-up Access: TCP/IP, modem, dial-up adapter  
and dial-up networking.
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Configuring communications: 
When you start WorldShip for the first time, you will see 
the Communications Setup window. Select at least one 
connection method and provide any necessary information  
to complete the connection setup:

n �Direct Access: a direct or broadband connection to the Internet 
that does not require dialing, such as Local Area Network 
(LAN), Wide Area Network (WAN), Digital Subscriber Line 
(DSL) or cable. Since Direct Access generally offers the 
fastest connection, UPS recommends this method. 

n �If you select Direct Access, you may need to identify the 
proxy server with the URL address, port and authorisation 
information. If a proxy server is used, you must also use 
specific browser settings.

n �Dial-up Access: a dial-up connection to the Internet through 
your existing Internet Service Provider (ISP). If you choose 
this option, select your existing ISP from the phone book list.

Reconfiguring communications:
1.	From the Tools menu, select Communications Setup.

2.	�In the Communications Setup window, make the necessary 
changes and click Next.

3.	�Continue making changes as needed. Click Finish to save 
your new configuration.

You should reconfigure communications when any of the 
following situations occur:

n Direct access to the Internet becomes available.

n �You see a message that one of your phone numbers  
is no longer valid.

n You change Dial-up Access or you change your modem.

n You change proxy server settings for Direct Access.

n You want to select a new phone number.

n You want to add or remove a connection method.

Registering with UPS
Once the application is successfully installed, you must 
register with UPS in order to ship packages using WorldShip.

Before you begin the registration process, make sure a printer 
is connected to your computer and is operational.

1. �After the WorldShip installation is complete and you have 
set up communications, the Register With UPS window 
appears. Enter the information about your company, where 
your system is installed and your UPS account number, and 
then click Finish.

2. �WorldShip automatically connects to UPS and transmits  
your registration information.

This may take three to five minutes. Please wait until the 
Shipping window appears.

Congratulations! You are now a WorldShip customer and are 
ready to process packages.

Post-Installation Checklist
1. �If you disabled any anti-spyware, anti-malware or virus 

scanner software, please enable it.

2. �If you receive a message that WorldShip cannot communicate 
with UPS, consult the computer technical support staff at 
your company.

3. �For WorldShip Workgroup Administrative Workstations: 
Please be aware that the WorldShip database will be 
disconnected if your Workgroup Administrative workstation 
goes into sleep mode. You must close WorldShip on both the 
Workgroup Administrative and Remote workstations and 
relaunch the application to resolve this issue. If necessary, 
consult your computer technical support staff for questions 
about sleep mode and how to adjust this setting.

4. �If you have a UPS-supplied printer, restart your printer prior 
to shipping by powering it off and then powering it back on. 
If you are on Microsoft Windows Vista/Windows 7 and 
you have a UPS-supplied thermal printer (Eltron®/Zebra®), 
you must install new printer drivers. Please follow the 
instructions below.

Uninstall Instructions
If you uninstall WorldShip, do not delete any of its 
directories without first running the uninstall program. 
When running the uninstall program, start it from the  
Start menu, Programs, UPS, UPS WorldShip Uninstall. 
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Installation procedure for Eltron/Zebra driver:

Note: The instructions below follow the “default view” format 
for Microsoft Windows Vista/Windows 7.

Remove current Eltron/Zebra Printers and Drivers.

1. �Click on Start in the Windows taskbar and select  
Control Panel.

2. �Select View Devices and Printers from the Hardware and 
Sound section.

3. �Empty the printer queue for each Eltron, Zebra and UPS 
thermal printer (such as UPS2844, etc.).

4. Go to C:\UPS\WSTD\FOSS\DRIVERS\ELTRON.

5. Double-click on ZebraUninstaller.exe.

6. Click on the Analysis button. 

7. When the analysis is complete, click on Clean. 

8. Click on OK to start the cleaning process.

9. �When the cleaning process is complete, click on OK. The 
Zebra Uninstaller will automatically close.

Installation Instructions to install Eltron/Zebra  
Thermal Label Printers on Microsoft Windows Vista/ 
Windows 7 with USB printers:

Note: For Serial/Parallel Printers, see next column.

1. �Ensure the printer is off, then plug the USB cable into the 
computer. Turn on the printer.

2. Launch WorldShip.

3. �On the Tools menu, select System Preferences Editor  
and then select the Printing Setup tab.

4. Under Label Printer, click Label Printer Setup.

5. Click Change Label Printer.

6. �Click Add Printer, choose Eltron/Zebra as your printer type 
and click Select.

7. �On the Zebra Printer Driver Installation window, click  
on Install Zebra Printer.

8. �In the Selecting the printer window, select Zebra from 
the Manufacturer’s window, and then select the printer 
from the Printers window. Example: Select the Zebra ZP 
Series-200 dpi for the Zebra ZP450. Select UPS Thermal 
2844 for the LP2844. Click on Next. 

  9. �In the Printer Options window, select the correct USB port 
and language. 

10. �Click on the Finish button. Windows will automatically 
install the printer drivers.

11. In the Printer Selection window, click on Cancel.

12. Click on Change Label Printer.

13. Select the printer name, and then click on Select.

14. �On the Label Printer Set-up window, select the printer 
stock dimensions and extended area usage. Click  
on Apply.

15. �On the Printing Set-up tab, click on the Doc and 
Consignee label tick boxes as needed, and then click  
on the OK button.

16. �Turn on the printer. The “Found New Hardware” wizard 
appears.

17. �If using Windows XP, select “No, not this time”, then click 
on Next.

18. �Select “Install the software automatically”, then click  
on Next.

19. Allow the software to install, then click on Finish.

Installation Instructions to install Eltron/Zebra Thermal 
Label Printers on Microsoft Windows Vista/Windows 7 
with Serial/Parallel printers:

1. �Plug the cable into the computer. Turn on the printer. 
Restart your PC.

2. Launch WorldShip.

3. �On the Tools menu, select System Preferences Editor  
and then select the Printing Setup tab.

4. Under Label Printer, click Label Printer Setup.

5. Click Change Label Printer.

6. �Click Add Printer, and choose Eltron/Zebra as your printer 
type and click Select.

7. �In the Zebra Printer Driver Installation window, click  
on Install Zebra Printer.

8. �In the Selecting the printer window, select Zebra from 
the Manufacturer’s window, and then select the printer 
from the Printers window. Example: Select the Zebra ZP 
Series-200 dpi for the Zebra ZP450. Select UPS Thermal 
2844 for the LP2844. Click on Next. 
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  9. �In the Printer Options window, select the correct port and 
language.

10. �Click on the Finish button. Windows will automatically 
install the printer drivers. 

11. In the Printer Selection window, click on Cancel.

12. Click on Change Label Printer.

13. Select the printer name, and then click on Select.

14. �In the Label Printer Set-up window, select the printer 
stock dimensions and extended area usage. Click on 
Apply.

15. �On the Printing Set-up tab, click on the Doc and 
Consignee label tick boxes as needed, and then click  
on the OK button.

Support Guides

WorldShip provides a User Guide, Installation Guide and 
Functions Shortcut Sheet in PDF format on ups.com®.

To view or print these documents, install the free Adobe® 
Reader® software from adobe.com and then follow these steps:

1. Go to ups.com/worldship.

2. Select your country/language and then click Go.

3. Select Get WorldShip Support.

4. Under User Guides, select View User Guides.

5. View and print the documents as needed.



Installation Guide WorldShip® 2012

Installation Guide  8© 2012 United Parcel Service of America, Inc. All rights reserved. 01/12

Technical Help
If you have questions about WorldShip that cannot be answered by this guide or WorldShip Help, call the following numbers:

Afghanistan. . . . . . . . . . . . . . . . . . . . . . . . . .                          9647814318252

Argentina . . . . . . . . . . . . . . . . . . . . . . . . . . . .                           0 800 888 8150

Armenia . . . . . . . . . . . . . . . . . . . . . . . . . . .                            10 3741 27 30 90

Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               1800 148 934

Austria. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 0800 312 407

Azerbaijan. . . . . . . . . . . . . . . . . . . . . . .                      +10 99 412 493 39 91

Belarus . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            375-17-227-2233

Belgium. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 0800 21 877

Bosnia. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  033 466 310

Brazil. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              55 11 569 46606

Canada . . . . . . . . . . . . . . .              1-888-UPS-TECH (1-888-877-8324)

Chile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  562 685 0755

China, People’s Republic of . . . . . . . . . . . . .            10 800 852 0698

Colombia. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               571 423 8775

Cyprus. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   77 77 7200

Czech Republic . . . . . . . . . . . . . . . . . . . . . . . . . . .                          800 143268

Denmark. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                80 33 22 55

Dominican Republic. . . . . . . . .         809 549 2777, 829 420 7947

Estonia. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               372 666 47 00

Finland . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                0800 187 722

France. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 0805 025 550

Germany. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              0800 100 2630

Greece. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               210-99 84 334

Hong Kong. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               8206 2133

Hungary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               06 80016482

India . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             00 0800 852 1113

Indonesia. . . . . . . . . . . . . . . . . . . . . . . . . . .                          001 803 852 3670

Ireland, Republic of. . . . . . . . . . . . . . . . . . . . . .                       1800 202 227

Israel. . . . . . . . . . . . . . . . . . . . . . . . . .                          00-972-(0) 56-890028

Italy. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    800 122 732

Japan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 00531 85 0020

Korea, South. . . . . . . . . . . . . . . . . . . . . . . .                        00798 8521 3669

Kyrgyzstan. . . . . . . . . . . . . . . . . . . . . . . . . .                         +996 312 699 988

Latvia. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      7805643

Lithuania. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             370-37-350505

Luxembourg . . . . . . . . . . . . . . . . . . . . .                    FR: 00 33 8050 10365

Malaysia. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               1800 80 4709

Mexico. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              01 800 714 65 35

Monaco. . . . . . . . . . . . . . . . . . . . . . . . . . . .                           00 33 8050 10365

Netherlands . . . . . . . . . . . . . . . . . . . . . . . . . .                           0800 222 5587

New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . .                            0800 443 785

Nigeria . . . . . . . . . . . . . . .                234 1 2704981-5, 234 1 2704992

Norway. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  800 32 255

Philippines . . . . . . . . . . . .            1 800 765 8065, 1 800 808 50020

Poland. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 022 203 0321

Portugal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800 783 458

Puerto Rico. . . . . . . . . . . .           1-888-UPS-TECH (1-888-877-8324)

Romania . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             40 21 233 88 77

Russia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              7 49 5961 2211

Saudi Arabia. . . . . . . . . . . .           966 1 462 6655, ext. 528 and 579

Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              800 852 3362

Slovakia. . . . . . . . . . . . . . . . . . . . . . . . .                          +421 (0)2 58250 281

Slovenia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             04/ 281 12 42

South Africa . . . . . . . . . . . . . . . . . . . . . . . . .                        +27 11 922 9200

Spain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 900 22 58 77

Sweden. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                020 120 2255

Switzerland. . . . . . . . . . . . . . . . . . . . . . . . . . . .                           0800 82 25 54

Taiwan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                00801 855 662

Thailand . . . . . . . . . . . . . . . . . . . . . . . . . . .                          001 800 852 3658

Turkey. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            90(212) 444 0066

United Arab Emirates . . . .   800-4774 (Local), + 971-4-339-1939

United Kingdom . . . . . . . . . . . . . . . . . . . . . . .                        0800 331 6010

United States. . . . . . . . . . . . . . . . . . . . . . . . . . .                           888-553-1118

Uzbekistan . . . . . . . . . . . . . . . . . . . . . . . . .                        +9987 1 120 3838


